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This manual may be freely copied for use with the EasySense2 app. As new features are continually being 
developed and released, so manuals will also be updated and be available from the Data Harvest website.   

 

Copyright: all rights reserved. 

Data Harvest's policy is to continually improve products and services, so we reserve the right to make changes 
without notice. It is acknowledged that there may be errors or omissions in this publication for which 
responsibility cannot be assumed. No liability will be accepted for loss or damage resulting from use of 
information contained in this manual or from uses as described. 
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System minimum requirements 

Microsoft Windows  
(Direct download via the Data 
Harvest website) 

Microsoft Windows 
(Download from 
Windows 10  Store) 

Apple Mac  Google 
Chromebook  

Apple iOS   Android 
(Tablet & 
SmartPhones) 

Windows 7 SP1, 8.1* & 10 

Requires minimum Internet 
Explorer 11 plus .Net 4.5.2.  

*Not suitable for Windows 8 

Windows 10  

(Version 1703 
Creators Edition or 
later) 

OS X 10.10 

64 bit processor  

 

Chrome  

OS 57  

 

iOS 10 

 

OS 6 

Methods of connection 

Windows OS X or macOS   Chromebook iOS devices Android devices 

       USB 

Bluetooth low 
energy (BLE)* 

 

       USB  

       Bluetooth low 
energy (BLE)*  

USB 

Wi-Fi 

Bluetooth low 
energy (BLE)* 

Bluetooth low 
energy (BLE)  
(iPad 3 or later) 

Wi- Fi       

Bluetooth low 
energy (BLE)   

Wi- Fi       

 

*Note: Only computers or devices with Bluetooth® low energy (BLE), also known as Smart or 4 are suitable. 
To check Bluetooth compatibility: 

Windows 10 macOS  

Right click Start         button, Device Manager, Bluetooth, 
look for the Bluetooth heading, check for Bluetooth LE 
Enumerator (Classic is not suitable). 

Select Apple menu,        About this Mac, More Info, System 
Report, Hardware, look for the Bluetooth heading, check to 
see if BLE is supported. 

BLE connection can be added by use of the Bluetooth USB Adaptor (Product No. 2070 or 2071). 

Supported devices 

  
 

 

VISION  

Firmware V 4.6 or higher 

V-Log 

Firmware V 2.1 or higher 

V-Hub  

Firmware V 1.4 or higher 

Vu+ 

Firmware V 1.6 or higher 

USB, Wi-Fi or Bluetooth*  

*Bluetooth requires a 
Bluetooth USB Adaptor 

USB, Bluetooth or Wi-Fi  USB, Bluetooth or Wi-Fi  USB or Bluetooth  

 

 

Vu (legacy product) 

Firmware V 1.4 or higher  

Wireless sensors  

Firmware V0 or higher. Android users require Firmware V2 or higher. 

USB  USB or Bluetooth 
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Installing the EasySense2 app 
EasySense2 is available as a download from the app store for your device, links are available from the Data 
Harvest website (www.data-harvest.co.uk).  

Note: The Windows direct download that is available from our website will not update automatically.  

Connecting a V-series data logger or Smart wireless sensor 

Note: V-series data logger refers to VISION, V-Log, V-Hub, Vu+ or Vu data loggers.  

USB connection  

The first time a V-series logger or wireless sensor is connected to a USB port on the computer its device drivers 
will automatically be installed. Plug in the data logger or sensor before opening the EasySense2 app.  

Bluetooth™ connection: 

Use the instructions provided for the data logger, wireless sensor or the Bluetooth USB adaptor. Check on the 

computer or tablet that Bluetooth is On. Do NOT pair the devices. 

Wi-Fi connection:  

Use the instructions provided for the data logger. For example on the iPad or Android tablet:  

Access point users: Check in Settings that Wi-Fi is On, select the loggers name from the list of available networks. 
Wait for confirmation that the network has been joined e.g. a tick or it shows as Connected.  

Infrastructure users: Connect the iPad or Android device to the schools network.  

The start  
Start the EasySense2 app.  
   

USB users: The Devices icon will automatically turn from Red (no 
interface detected) to Green with the interface detected and its 
sensors shown below.  
 

Internal sensors are off by default, to switch on or 
change the range of the sensors select the Devices icon. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: This window is also available as 
New Lab from the File menu 

Tap or click the X to accept and close  

 

Slide switch 
grey indicates 
the sensor is 
Off (so no 
readings will 
be taken from 
this sensor). 
Tap or click to 
switch On. 

 

To change the range of the 
sensor tap or click the down 
arrow and select from the list  

Tap or click to connect another Bluetooth 
data logger or Smart wireless sensor 

 

Refresh  

USB icon 

Slide switch 
indicates this 
sensor is On. 
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Tap or click the X to 
accept and close  

 

Internal sensors are off by 
default, tap or click the slide 
switch to switch them on 

 

To change the range of 
the sensor tap or click the 
down arrow and select 
from the list  

Tap or click here to connect 
another Bluetooth data logger 
or wireless Smart sensor 

 

Refresh  

Bluetooth or Wi-Fi users:  

1. Select the red Devices icon. 

 

 

 

 

 

 

 

2. Select the data logger or 
wireless sensor from the list 
of available devices.  

 

Note: This list is also available 
from the Devices icon on the 
main screen. 

 

 

3. Select Connect. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Templates 
There are a choice of pre-set templates available from Lab Setup (or via File -> 
New Lab).  

For example a template of: 

 Graph - fills the whole chart area with a line graph display 

 Graph + Table - a two chart template, 66% showing a line Graph display and 33% showing a Table.  

 A Titration set up. A line graph and table display, in Snapshot mode with an ‘Enter Volume’ function. Each 
time you click in Take Sample to record the value, an enter value box will appear for you to type in a 
number from your keyboard. Enter the TOTAL volume added so far. 

 A Speed at A then B setup. A bar graph and table display, in Timing mode to record Speed 
at A (u), Speed at B (v) and Time from A to B (t). The apparatus set is a single interrupt card 
120 mm in length. Created for students to calculate Acceleration (the change in velocity 
over time) using the Dynamics system apparatus.  

Wi-Fi icon 

Connect  

Refresh  

Bluetooth icon 

t 

u v 
a 

) (  
 

Note: This window is 
also available as New 

Lab from the File menu 

Devices icon 
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The EasySense2 main screen 
 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Toolbar 
 

 

 

 

 

 

 

 

 

 

 

 

 

Start or Stop 
recording 

Overlay - adds a 
new set of data 
without the 
previous set 
being erased 

Tap or click below the chart 
area to select X-Axis options 

Setup – to select 
sensors, their ranges, 
the mode of logging, 
start and stop 
conditions.  

Toolbar 

Tap or click in the 
area left of the 
chart to select the 
Y-axis choices e.g. 
sensor displayed, 
and auto scale 
options. Data will 
be displayed on a 
common axis 
unless Multi Scale 
from chart options 
is selected 

 

Options for this chart 
(Clear, Title, Multi Scale, 

Grid & Zoom) 

Chart (single chart shown) 

Connect to a data logger 
or wireless sensor 

Data series boxes, 
tap or click on a 
box to view 
information about 
this sensor’s data 
e.g. name, units, 
source and 
Min/Max sample 
recorded 

Tap or click to 
select either 
Time or Reading 
number for 
both graph and 
table charts   

 

To select which 
series of data to 

display on this chart 

Select the type of 
chart displayed 
i.e. graph, table, 
dial or numeric  

Open or Save a file, Import a 
saved file to merge with data, 

Import data from a device 
(retrieve), clear all data (New 
Lab), export data as a csv file, 

and Print 

Analysis Tools i.e.  
Values, Difference, 

Gradient, Area, 
Crosshair 

 

Settings - change 
position of toolbar, 

Version no, 
Graph line thickness 

Connect to a data logger 
or wireless sensor  

Logged data is stored as a 
run in time and date order. 

Use to select whether a 
run should be deleted, 
hidden or be displayed 

 

Use to select 
the number of 

charts and 
their layout 

Use a formula to 
calculate a new 
series of data 



EasySense2   DO277 (2)
  
  

8 

 

Recording data 
To begin recording click on the Start icon.  

 

During logging the icon will alter to Stop and show a red square. Click on this icon to 
stop data being recorded. 

If you want to clear the recorded data and repeat the last experiment (with all of the 
settings the same) simply click on the Start icon again.  

If you want to collect data, without the previous set of data being erased, select Overlay 
before you click on Start. The new data will be superimposed on the data already on the 
graph.   

To set up a new investigation e.g. to identify a change of sensor or change a sensor’s 
range, alter the mode of logging, start or stop conditions, select the Setup icon.  

The logged data will clear from the chart and be stored as a run which 
can be accessed or deleted via the Run icon.  

 

 

Select New Lab from the File menu to re-start from the beginning i.e. open a new 
template, clear the collected data, delete stored runs of data but retain the chart 
display and settings opted for in Setup.     

 

Experiment Setup 
Select the Setup icon (bottom left of screen).  

 

 

 

 

 

 

 

 

 

 

Sensors: (selection and or alter sensor’s range). Select the edit symbol. 

 

 

 

 

 

 

 

 

 

 

Internal sensors are off by 
default, tap or click the slide 
switch to switch on. 

 

Deselect any sensors from 
which readings are not 
required  

 

To change the range of 
the sensor, tap or click 
the down arrow and 
select from the list 

 

Tap or click Connect to 
add another wireless 
logger or sensor 

 

Refresh to identify a 
change of sensor 

Edit symbol 

Choice symbol 

Refresh device 
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Mode: Select the choice symbol           and choose your mode of logging. 

Continuous samples  

Pre-set to record sensor values continuously as a line graph until the stop 
condition is reached.  
 

 Select Continuous as the mode.  

 Select the interval between samples being taken (spans from 20 µs to 7 days).   

Notes: The fastest logging speed of the Vu+ data logger and the Bluetooth wireless pH and Temperature sensors is 
50 samples per second so intervals shorter than 20 ms will not be available to select.  

If intervals are less than 20 ms with a V-series data logger connected, recording will done be in FAST mode (log + 
retrieve), when no data is displayed until the recording ends. 

 Select the condition required for the recording to start. The choice of start conditions and triggers 
available will depend on the type of logger and the recording time selected.  

 

o When start is selected. To begin recording as soon as you click on the Start icon. 

o Trigger when the value from the sensor selected is:  

 

 

                             

 

 

 

     

                                                

 
 

 Select any pre-trigger requirements.  

Note: This option is available for Smart Wireless Bluetooth sensors if a trigger on level condition is selected.  

Pre-trigger stores samples prior to the trigger condition being met and then displays the results. For 
example, to capture an entire induced voltage event you will require data to be recorded prior to the 
voltage rising up to the value set for the triggered start e.g. record data for 500 ms before the voltage 
rises above 0.04 V.   

 Select the stop condition  

o When stop is selected (only available if an interval higher than 20 ms is selected). 

o After a duration. The number of samples will automatically alter as the duration is being selected.  

o After a specified number of samples. Tap or click in the Sample Count box and type in the number 
required. 

 

Once ► Start is selected logging will begin when the start condition you have selected is met.  
 

Snapshot (manual sampling)  

The graph will open pre-set to record sensor values on demand. 
 

 Select Snapshot as the mode. 

 Manual entry - if selected each time you take a sample a dialog box will appear for you to enter a number, 
these entries will create a set of data. Enter a name and the units for this data series.  

 Select the stop condition (when stop is selected, after a duration, or after a specified number of samples).  

 

 

SET LEVEL 

Higher than 

To start recording 
when the value from a 
sensor is above the 
set level. 

SET LEVEL 

Value rises above                   

Logging will not start 
until the value from a 
sensor rises up above 
the set level.  

SET LEVEL 

Lower than 

To start recording 
when the value from 
a sensor is below the 
set level. 

Value falls below  

Logging will not start 
until the value from a 
sensor falls below the 
set level.  

SET LEVEL 
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Select ► Start and tap or click on Take Sample.  

 

If manual entry was selected type in the value and select Save sample.   
 

Logging will continue until the stop condition is met. 
 

Timing 

Timing is used to allow students to study Time, Velocity, Acceleration, 
Momentum and Kinetic Energy relationships using switch-type (digital) 
sensors such as Light gates which only have two states, ON or OFF.  

Connect the digital sensors being used to the interface, measurements can be taken from either a single 
sensor connected to Input A, or from two sensors connected to both Input A and B. The graph will be pre-set 
to record as a bar graph display against reading number.  
 

 Select the mode as Timing.  

 Select 

1. What you would like to measure e.g. Time, Speed/Velocity, Acceleration, Distance, Momentum and 
Kinetic Energy, Raw data. 

2. Select whether you want to measure at A, at A or B, from A to B, at A then B, from A to A, Pendulum. 

3. Select the type of apparatus being used and the measurement required by the calculation e.g. to 
calculate speed from A to B, enter the distance between the two digital sensors connected to A and B. 

4. If required select to display any of the data sets used in the calculation.  

5. Select the stop condition (when stop is selected, after a duration, or after a chosen number of 
samples).  

 

Select ► Start. When a signal change from the digital sensor/sensors is received, the timing measurement will 
automatically be entered. The vertical axis scale automatically adjusts to match the largest value collected. See 
page 23 for further information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

This diagram shows a typical apparatus set up for use with Timing. Light gates are connected to Input A and B 
on data logger and are used to monitor the movement of a cart down a track. An interrupt card is fixed to the 
top of the cart and this card will cut through the Light gate’s infrared beam. 
 

A 
B 
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Displaying graphs  
Up to 4 charts can be open at one time and they can be any combination of sensors and displays.  

 

 

 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

For example a 4 chart display, chart 1 = Line graph with just the Sound sensor displayed, chart 2 = dials of all 4 sensors, 
chart 3 = numeric display of 2 of the sensors, chart 4 = table of all 4 sensors. 

 

If you want more than one 
chart open select the 

LAYOUT icon and choose 
from the selection available 

Tap or click here to 
select the series to 
display on the X axis  

Select the Chart options 
icon        to Zoom, Multi 

Scale axis enter a Title or 
Grid in this chart 

Tap or click here to 
change the X axis 
display from Time 

to Reading number 
on both graph and 

table charts 

The colour circle in 
the data series box 
corresponds to the 

colour of the 
plotted line 

Tap or click here to 
select the data series to 
display on the Y axis and 
scale data (default, Min 
to Max, 0 to Max). Data 
will be displayed on a 
common axis unless 
Multi Scale from chart 
options is selected 

Tap or click here to 
select the type of chart 
to display e.g. line 
graph, bar graph, table, 
dial and numeric  

Table of all 4 sensors 

Tap or click here to show or hide 
data displayed in this chart Logging information  

The Numeric chart 
displays the currently 
measured value as a 
number  

 

The Dial chart displays 
a traditional circular 
dial whose pointer 
moves to the right as 
the measured value 
increases and moves 
to the left as the value 
decreases.  

 

Tap or click here to select the time or data 
series to display on the X axis and scale data  



EasySense2   DO277 (2)
  
  

12 

 

Chart options 
Some display options are applied on an individual chart basis rather than to all charts. Select the chart options 
icon        top right of the chart you want to alter. The options available will depend on the chart type selected.  

 

 

 

 

 

 

 

 

 

 

 

 

Maximise  

A chart can be maximized to fill the whole area by selecting Maximize from the chart options icon. Select 
Restore to return to original screen size.  

Clear 

Use to clear empty a chart of all data and deselect the chart type. Data is not deleted, use Runs to re-plot the 
data. 

Title 

Select Title. Tap or click on the grey Enter Title text above the chart. Type in the text for the title and select X      
to accept & close.  

 

  

 

 

 

 

 

 

 

 

 

 

To edit click on the title text and alter as required. To hide deselect Title.   

Multi Scale 

By default data is displayed on a common axis (all sensors share the same axis scale), so the maximum and 
minimum value will be dependent on the highest and lowest limits combined of all sensors connected. Select 
Multi Scale from chart options to change so that each sensor uses its own axis label and numeric scale 
markings. Tap or click on the sensor’s name to select which sensor to display on the Y-axis. 

See the next page for an example of 4 charts, each showing the same data but displayed in different formats. 

 

Table, Numeric 
and Dial options 

Line or Bar 
graph options 

Accept and close 
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Grid 

Select whether a Grid should be On or Off the graph. If a grid is selected then a faint grating is marked on the graph.  

Zoom  

An area of the graph can be magnified so that a particular area can be seen in greater detail.   

Click and drag method:  

  
 

 

Select Zoom in. Position your finger or 
the mouse pointer at the top corner of 
the area to be magnified. 

Click or tap, hold down and drag 
the rectangular box over the area 
to be magnified. 

Release to show the magnified 
area.   

 

Point method: 

 

 

Select Zoom in. Position the mouse pointer or 
tap on the screen at the area to be magnified. 

The area will magnify and redraw 
automatically  

Data from all 3 sensors 
displayed on a 
common axis (default)  

Light’s range = 0 to 100,000,  

Carbon Dioxide = 0 to 10,000,  

Oxygen = 0 to 25%,  

∴ Axis minimum is 0 and 
maximum of 100000   

All 3 sensors on 
common axis, Min to 
Max scale applied  

Light values = 0 to 20,000  

CO2 = 98 to 1,370 ppm 
Oxygen = 18 to 22.8% 

∴ Axis minimum is 0 and 
maximum of 25,000   

 

Chart Options  

Multi Scale from Chart 
Options selected 

Light’s range = 0 to 100,000,  

Carbon Dioxide = 0 to 10,000,  

Oxygen = 0 to 25%,  

Scale is that of the 
sensor chosen to be 
displayed on the Y axis 
i.e. Oxygen  

Multi Scale selected  

Auto scale Min to 
Max applied. 

The scale for each 
sensor is re set to 
the min – max of the 
recorded data. 

Y Axis choices (axis to 
display and auto scale Min 
to Max or Zero to Max)  
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To expand this magnified area further select Zoom in and repeat the above. 

Select Zoom Out to zoom out by one step.  

Select Zoom Off to return to the original graph.  

Chart Layouts 
To change the number of charts or their orientation 
select the Layout icon.  
 

To alter the type of chart displayed e.g. from graph to 
table, select from the chart icon (top left of the chart).  

 

 

 

 

 

 

 

 

Bar or Line Graph 
Select line or bar graph from the chart icon top left of a chart.  

With a Line Graph individual readings are by default joined by a 
line. There is a choice of three different thickness of line available 
from the Settings menu.  
 

With a Bar Graph readings will be shown as bars of colour. 
 

Data Series  
The colour circle in a data series box corresponds to the colour of the plotted line. 

Tap or click on a box to view information about the data collected from a sensor or derived data e.g. name, 
units, the source of the data (e.g. data logger’s name, file name, etc.) and the highest or lowest value sample 
recorded. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Line graph 

Numeric 

Dial 

Table 

Bar graph 

Layout icon 
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Tap or click in 
this area for Y 
Axis options 

Tap or click in this area for X Axis options 

Autoscale  
Normally the full scale of all sensors are displayed on a common axis. If Multi Scale from chart options is 
selected then each sensor will be displayed using its own axis label and scale markings. The data from Wireless 
Bluetooth sensors will scale automatically as data is collected.     

If the scale of an axis is too large the axis can be scaled using the values of the data collected. 

  

 

 

  

 

 

 

 

 

 
 

3. Choose between  

 Default: Restore the limits to the full scale of the sensors. 

 Min to Max: Rescale the Y-axis to the maximum and minimum limits of 
the data   

 Zero to Max: Rescale the Y axis using a minimum of zero to the 
maximum of the data  

 

Axis options 
Tap or click on the axis label (grey area round the axis name) to open the options for the X-Axis or Y-Axis.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Select whether you would like Time, Reading Number or a Data Series (e.g. sensor) displayed on the axis. 

 Reading - set to the number of single readings taken, without any regular time interval between 
them. This axis is often used for Snapshot data. 

 Seconds - time axis as seconds [Time (s)]. 

 Time - elapsed time in days, hours, minutes and seconds [Time (d:h:m:s.ms)].  

 Data Series e.g. Sensors. 

1. Tap or click on 
the axis label 

2. Select the down arrow 
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(2) Deselect any run of 
data that you want to 
hide from view  

(1) Tap or click on the Runs icon  

Tap or click on the bin 
to delete a run of data 

Show or Hide data  
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Runs  
When data has been logged it is stored as a ‘run’ of data from all active sensors. If you select 
Start again the graph will clear and a new run of data will be created. Multiple runs of data can 
be collected for comparison. Select the Runs icon and select the ones you want to view, runs 
are listed in time and date order.  

 

 

 
 

 

 

 

 

 

 

Delete data 
To delete individual runs of data select the Runs icon and the bin image to delete. 

Select New Lab from the File menu to clear the collected data and delete all stored runs of data. 

 

(1) Tap or click on the colour swatch at the top of 
the chart area (grey area with coloured circles) 

 

(2)  Deselect any data series (sensor) 
that you want to hide from view 
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Difference 
between the 
data at these 
two points  

Time interval  

Analysing captured data 
There are a number of tools available to allow the analysis of captured data. Select Tools 
from the menu bar to open the analysis menu. 

Values  
Tap or click the slide switch to select Values. Tap or click in the graph or table chart at the point where 
information is needed. A cursor line will appear on the graph at the nearest data point and highlight in a table. 
Values at that point will be shown in the values box or numeric chart. The display mode box will indicate the 
time or reading number of that data point. The cursor can be dragged to any point. 

To deselect select the Tools icon and tap or click on Values.  

Note: If the X-axis is a sensor, select Crosshair instead of Values to indicate what the value from the sensors would be if 
they crossed at the cursor point.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Difference and Interval 
Select Difference, two cursor lines will appear in the graph area. Move one cursor line to the first reading to be 
used in the comparison and the other line to the second point. The data in between will be highlighted in the 
table and the values in the data series box will be the difference between the data at those two points. The 
display mode box will indicate the time interval between the two selected points. 

The cursors can be dragged to any point. To deselect select the Tools icon and tap or click on Difference.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Cursor line 

Values at this 
data point  

Time at the 
selected point  

2 cursor lines 
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Gradient  
This feature calculates the rate of change of data in the vicinity of the cursor. When the graph line is horizontal 
the gradient is zero and values are not changing. A positive gradient shows that values are increasing – the 
larger the gradient, the faster the change. Select Gradient, move the two vertical cursors to the position from 
which information is required, a dashed line will indicate the slope of the graph for each data series. The 
gradient value between the two cursors will be shown in the data series boxes.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

To deselect select the Tools icon and tap or click on Gradient again.  
 

Area  
This feature is used to calculate and display the area under a chosen section of the graph. The calculation for 
area is performed on the data from all channels. The units correspond to the product of the Y and X-axis.   

From the Tools icon select Area, move the two vertical cursor lines to the start and end point. Shading lines 
will mark the section under the graph for each data series. The values for area will be shown in the data series 
boxes.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

To deselect select the Tools icon and tap or click on Area again.  

2 cursor lines 

Gradient for 
each data 
series 
between the 
two cursors 

Dashed gradient line indicates the slope  

Cursor lines 

Area between 
the two cursors 
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Crosshair  
This feature shows the value at the point that a vertical and horizontal line cross.  

Select Crosshair, click and drag the point of the crossover to the position from which information is required. 
The label will show the value of the X and Y axis at that data point. Use to interpolate data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Calculate function  
Calculate is for mathematical operations that can be applied to data. These can be applied to data as it is being 
collected or after the data has been collected.  

1. Select the Calculate icon from the toolbar. 

2. Select Add series. 
 

 

You can delete or change a calculated series after it has been 
applied by selecting the CaIculate icon and then the edit symbol 
for the series.  

 3. Enter a name for the series, the number of decimal 
places to be displayed and the units for the new data. 
Decimals should at least equal the sensor’s resolution.  

4. Click on the down arrow to view the formulae available 
and select from the list (see notes). 

5. Enter any parameters required by the formula for ‘a’ 
and/or ‘b’. E.g. type in a multiplier, constant or scaler. 
Numbers can be negative or positive (make sure there 
isn’t a space between the + or – sign and the number). 

6. Select the data channel(s) to be used as the source of x 
and/or y if required by the formula. Click on the arrow to 
reveal the list of sensors connected. The list will include 
any derived data channels. 

7. Select Apply and the calculated data will appear on the 
graph, if a mistake has been made select Delete Series.   

Label shows x = 1.816 (Voltage)  

                       y = 28.186 (Current)  

3 

4 

5 

6 

7 

Edit symbol 
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If you are applying a calculation prior to logging, click on the Start icon. Data will be calculated and displayed 
on the graph and table.  

Notes: 

Formulae available are:   

a ax a/x 

ax + b ax + by sin(ax) 

cos(ax) axy axy/b 

ax/by dx/dt Moving average 
 

 The data channel(s) list is presented in the order of the connected sensor ports. 

 A negative number multiplied by a positive number creates a negative. 

 A negative number multiplied by a negative number creates a positive.  

 Any number multiplied by zero = 0. A number multiplied by 1 gives the same number.  

 To remove part of a function set the constant’s (a or b) number to zero. E.g. To multiplying a data set 
by a constant would require an ax function. The function ax + by can be altered to ax by setting b to 0 
(0 multiplied by y = 0).  

 To leave the value of a data set unchanged by a calculation then the value of a or b should be set as 1. 
E.g. when adding two data sets there is no function x + y but there is ax + by. By setting both a and b 
to 1 makes the function ax +by = 1x +1y = x + y.  

 When calculating moving average ensure the decimal places are set to at least the resolution of the 
sensor e.g.  Voltage recorded to three decimal places (4.174 V) so set decimals to a minimum of 3. 

Changing Settings 

Changing a sensor’s range  
Some sensors have multiple ranges e.g. a Light Level Sensor. The places from which you can change a sensor’s 
range to one suitable for an experiment are: 

 

1. From the Devices icon (top left of screen) or Lab Setup.  

2. Setup (bottom left of screen)                                                                                                          

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Choice symbol 

If the sensor only has one range the 
down arrow (choice symbol) will be 
missing.  

Range currently selected 

From the sensors row 
select the edit symbol 



EasySense2   DO277 (2)
  
  

21 

 

 From the sensors row select the edit symbol.  

 Select the choice symbol ▼ for the sensor in question and a drop-down list of ranges will open.  

 The range currently selected will be highlighted. Select the required range 

The sensor range setting will be retained until changed by the user. 

 

Calibrating a sensor 
The stored calibration for a pH Sensor is the Default calibration. If required the calibration constants of a pH 
electrode can be adjusted. The settings for an electrode will be stored in the Adaptor as the User calibration.  

Note: Mark the pH electrode and adaptor combination so they are used as a pair.   

How to calibrate 

1. Change the sensor’s range to User Cal.  

2. Select the Calibrate button. 

 

3. If only two samples of buffers are being used select 
the choice symbol        for Calibration Type, then 
Two point from the list.   

4. Type in the value of all the buffers being used to 
set points into the appropriate boxes. 

5. Rinse the electrode in distilled water. Wipe off the 
excess and suspend the electrode in the value one 
buffer solution, stir and select Calibrate.  

6. After the 20 second count rinse the electrode in 
distilled water, wipe off excess, suspend in the 
value two buffer, stir and select Next.  

7. After the next count down rinse the electrode in 
distilled water, wipe off excess and suspend in the 
value 3 buffer, stir and select Next.  

8. After the next count a message will say ‘Your sensor has been calibrated ……’ Select Finish. Unplug and 
re-plug the pH sensor into the data logger.  

Note: Mark the pH electrode and adaptor combination so they are used as a pair.   

The User calibration values will be stored in the Adaptor and will be retained until reconfigured by the user.  

 

Overlay  
Select the Overlay icon from the bottom toolbar to add a new set of data to the 
graph without the previous set of data being erased - useful for repeating an 
experiment to compare data. The icon will ‘green’ up to show it is selected.  

 

 

 

 

 

 

(1) 
(2) 

(3) 

(4) 

(5) 
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Toolbar  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To move the Toolbar from the top to 
the left of the screen select the Settings 
icon and deselect Toolbar at top.  

 

 

 

 

 

 

File menu options 

Open File  
Use to load a previously saved EasySense2 or an original EasySense file 
(*.es2 or *.ssl file type). 

Save 
A dialog box will open to allow the captured data to be saved as an 
EasySense2 file using a filename of your choice. Saved as *.es2 type file. 

Manage (iOS version and Android) 

Select your file then either use Share to email your data file as an 
attachment or Delete to permanently erase the file. 

Import from File       
Use to merge the current data with a saved *.es2 or *.ssl file. The data has to be logged using the same mode 
of logging. [Mode being either Continuous, Snapshot or Timing].   
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Import from Device 
Use this option to retrieve a data set stored in your data logger or devices memory (remotely captured data). 
Retrieved data can be used in the same way as real-time data i.e. it can be analysed, saved and printed. 

A dialog box will open showing a list of the data sets presently stored in the data logger in order of the date and 
time recorded (as set by the data logger). Select the required set of data  

Export CSV 
Use to export (save) the collected data in a .CSV file format. Files saved in CSV format (comma-separated 
values) are a simple text format suitable for database/spreadsheet systems e.g. Microsoft Excel.  

New Lab  
Use to clear the collected data, delete data stored as runs, open a new template, but retain the chart display 
and settings opted for in Setup.  

Print  
To print out a copy of the current screen display. 

App’s version number 
The version of the EasySense app can be 
found by select the Settings icon.  

 

 

 

 

• Windows Store - installed via the Microsoft Windows 10 Store and updates automatically (recommended 
method), ensures the software is always up to date. 

• Windows Classic – a more traditional version installed from a direct download from the Data Harvest’s 
website, comes with an .msi installer. This version does not update automatically.  

 

Timing mode information  

Measure Where 

Time  at A 

 at A or B 

 from A to B 

 at A then B 

 from A to A e.g. Stopwatch 

 Pendulum (period at A) 

1 

Measure Where Apparatus  Measurement 

Speed or 
Velocity 

at A Single interrupt card Length of card (mm) 

  Double interrupt card Segment length (mm) 

  Picket fence Fence pitch  (mm) 
Calculation increment  
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  Pulley - 

 at A or B Single interrupt card Length of card (mm) 

 from A to B - Distance from A to B (m) 

 at A then B Single interrupt card Length of card (mm) 
 

Distance at A Picket fence Fence pitch (mm), Calculation 
increment 

  Pulley          - 
 

Acceleration at A Double interrupt card Segment length (mm) 

  Picket fence Fence pitch  (mm) 
Calculation increment 

  Pulley - 

  at A or B Double interrupt card Segment length (mm) 

 from A to B Single interrupt card Length of card (mm) 

 at A then B Double interrupt card Segment length (mm) 

 change from A to B Double interrupt card Segment length (mm) 
 

Momentum 
and Kinetic 
Energy 

at A Single interrupt card Length of card (mm) 
Mass of object passing through A (kg) 

  Double interrupt card Segment length (mm) 
Mass of object passing through A (kg)  

  Picket fence 

 

Fence pitch (mm) 
Calculation increment  
Mass of object passing through A (kg)   

  Pulley Mass of object passing through A (kg)         

Measure Where Apparatus  Measurement 

 at A or B Single interrupt card 

 

Length of card (mm) 
Mass of object passing through A (kg) 
Mass of object passing through B (kg) 

 from A to B  Distance from A to B (m) 
Mass of object passing through A (kg) 

 at A then B Single interrupt card 

 

Length of card (mm) 
Mass of object passing through A (kg) 
Mass of object passing through B (kg) 

 at A then A Single interrupt card Length of card  (mm) 
Mass of object passing through A (kg) 

 Stopwatch (change 
from A to A) 

Single interrupt card Length of card (mm) 
Mass of object passing through A (kg)  

 change from A to B  Single interrupt card 

 

Length of card (mm) 
Mass of object passing through A (kg) 
Mass of object passing through B (kg)   

 

Measure Where 

Raw data  (interrupt edge times) at A 

at A or B 
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Timing measurements 

Measurement at A   

Uses one digital sensor connected to Input A. Timing starts when the signal from Input A changes (ON) and 
stops when the signal reverts back (OFF). 

 If Light Gates are used with a single interrupt card, the time measured is for how long the card took to 
pass through the sensor.  

 For a Push Switch it will be the length of time that the switch is kept depressed.  

 For Timing mats it will be the length of time someone stands on the mat.  

Measurement at A or B 

Uses two sensors connected to Input A and B. A measurement will be taken from whichever sensor detects the 
change in signal level. The measurement will be the time to pass through either sensor A or sensor B. 

Measurement from A to B 

Uses two sensors connected to Input A and B. A measurement is taken for the time an object takes to travel 
from the sensor at Input A to the sensor at Input B. Timing will start when the signal change at Input A is 
detected  and stops when the signal at Input B changes.  

Measurement at A then B 

Uses two sensors connected to Input A and B. Three measurements are recorded of an object travelling from 
the sensor at Input A to the sensor at Input B. The measurements are: 

1. Time to pass through Sensor A 

2. Time to pass through Sensor B 

3. Time to travel from A to B 

Measurement at A then A 

Uses one digital sensor connected to Input A. Time will be measured for a single interrupt card passing through 
a Light Gate (A1), and then returning back through (A2). E.g. for rebound collisions.  

Measurement from A to A  

E.g. stopwatch 

Uses one digital sensor connected to Input A.  

Timing will start when the signal at input A changes (ON) and will continue until the signal at A 
goes OFF and then ON again.  

Change from A to A 

Uses one digital sensor connected to Input A. The measurement will be for the change in 
value from A2 to A1 e.g. for a single interrupt card passing through a Light Gate and returning 
back through.  

Change from A to B  

Uses two sensors connected to Input A and B. A double interrupt card is used to measure the acceleration at A 
and then at B. The measurement shown will be the change in acceleration (Acceleration at B – Acceleration at 
A).  

Distance at A 

Use the Picket fence or Pulley, with a Light Gate connected to Input A, to measure the distance moved. 
Distance is calculated using the step size of the Data Harvest Pulley, or the pitch length of the Picket fence. 
Each time a new gap in the Pulley or the pitch of the Picket fence is reached; the distance moved is known. 
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Point at which 
the pendulum 
starts and stops 
the recording

Back

Forward

A

Period at A  

E.g. pendulum 

 

 

 

 

 

 

 

Raw Times 

Timing is usually started when the solid black part of an interrupt card 
blocks the infrared beam on a Light Gate and changes the logic level 
from 0 to 1. When the clear part of the card is reached, the infrared 
beam is restored and its logic state changes back to 0 and the event 
time is taken. Raw times show the logic levels as 0 and 1 values with 
the time of the event.   
 

Timing apparatus 

Single Interrupt card 

Measure the solid part of the card that will pass through the Light Gate 
(mm). Speed is calculated using the length of the interrupt card divided by 
the time taken for the card to pass 

 
 

Double Interrupt card 

The two segments of a double interrupt card must 
be equal in width. Measure the solid part of the 
card that will pass through the Light Gate (mm). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Start the pendulum swinging, when it is moving freely click 
on the Start icon. 
  

Timing will start when the pendulum first passes through 
the Light Gate. When the pendulum passes back through, it 
will ignore the second signal change and will stop at the 
third change (when the pendulum arrives back at the Light 
Gate). The time shown will be for a complete period.  

 

 

E.g. Average acceleration can be measured using a single Light 
Gate with a double interrupt card. Acceleration is calculated using 
the length of the segments on the double interrupt card.  

 

 

 

 

 

 

 

 

Acceleration = Change in Velocity = 
                               Time taken 

  

   V2   Length of segment   - V1   Length of segment    

                     Time                                        Time 
 

                                   Time taken  

1             0              1              0    

   

 

V2 

V1 

Time 
taken for 
velocity to 
change 
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Picket fence  

The picket fence is a multi-segmented 
interrupt card so a sequence of measurements 
will be taken.  

To improve the accuracy of readings, a 
calculation increment can be applied to 
average the times over fewer pitches.  
  

Note: A calculation increment (of more than 1) will result in fewer measurements than the number of pitches on a fence 
might indicate. 

 

 

 

 

 

 

 

 

*Note: If a picket fence with a pitch length of 10 mm is used with buggy type investigations (which produce slower times 
than gravity investigations), the times can be averaged over less pitches so the calculation increment could be reduced to 5.  

When a Picket fence is used to measure speed or acceleration, the measurements shown are for 
instantaneous values i.e. it took this amount of time to travel this distance and the acceleration was.  
 

Spoked Pulley 

The measurements for the Data Harvest Spoked Pulley are pre-defined.  

The spokes on the pulley can easily interrupt the Light Gates beam to 
create false results. Wait until all is ready before you click on the Start 
icon.  

When a Spoked Pulley is used to measure speed or acceleration, the 
measurements shown are for instantaneous values i.e. at this distance, the 
speed was.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pitch length (l) Suggested calculation increment 

60 mm or more 1 

50 mm 2 

40 mm 2 

30 mm 3 

20 mm 4 

*10 mm 5 - 8 

 

Measure from the start of one black edge to the start of the next black edge.  
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EasySense2 Multi-user Site Licence 
 

Definitions 

The following expressions have the meanings given here: 

 ‘DHG’ means Data Harvest Group Limited, being owner of all intellectual property rights in the 
Software 

 ‘Documentation’ means both printed and electronic user documentation. 

 ‘Software’ means the app supplied. 
 

Licence 

This software package may be freely used, copied, and disseminated. This includes any associated 
documentation and user guides.  

The software may not be amended, changed or altered in anyway.   
 

Limited Warranty and Disclaimer of Liability 

The Software is supplied ‘as is’; DHG makes no warranty, whether express or implied, as to the merchant 
ability of the Software or its fitness for any particular purpose. In no circumstances will DHG be liable for any 
damage, loss of profits, goodwill or for any indirect or consequential loss arising out of your use of the 
Software, or inability to use the Software, even if DHG has been advised of the possibility of such loss. 
 

General 

These conditions supersede any prior agreement, oral or written, between the licensee and DHG relating to 
the software. 

 

 

 


